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Learner Handout: Email Basics  

Email is a way to send mail digitally through the internet.  

Creating a Username  

• Usernames must be unique, so it may be hard to find something not already taken. 

• You may need to add numbers or other identifying factors to it. 

• Select a username that is appropriate to share with anyone you may give your email to, such as 

your child’s teacher or an employer.  

• Enter your name and create a password for your account.  

 

a. My email address is: ___________________________________________  

 

b. My password is: _______________________________________________  

 

 

 

Tips for Strong Passwords 

• Don’t share your password with others. Passwords should be kept private.  

• Gmail requires a password that is a minimum of eight characters.  

• It should not be easy to guess, like “password” or “123456.”  

• Don’t include personal information, like your address or name. 

• Don’t use the same password on multiple accounts and websites. 

• Make the password longer. The best defense is length.  

• Use short phrases like “cowshelpmakecheese.” 
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Inbox 

 

 

 

Search: Look for specific messages using the search box.  

Compose: Create an email to send to another person or people.  

Menu: Allows you to switch between folders that organize your email messages.  

Inbox: Where your email is received.  

Sent: Where you find the message you have sent.  

Draft: A saved copy of an email that you have not completed. You can edit it later and send it. 

Trash: Where deleted emails are stored temporarily—usually for about 30 days—and then deleted 

permanently. 

Spam: Unwanted online communication. 

Log Out: Sign out of your account when you are finished so no one else can access it.  

 

  



3 
 

Messages 

 

 

 

 

Reply: Email goes only to the person who sent the message. 

Reply All: Sends the email to everyone who received the message. 

Forward: Sends an existing email to another person.  

 

 

 

 

 

 

 

 

To: The email address(es) of the person or people you are sending the message to. 

CC: Carbon Copy. 

BCC: Blind Carbon Copy. The people receiving the email can’t see who is inside the BCC field.  

Subject: Lets the person know what the message is about. 

Body: The message you’re sending.  

Attachment  : Files included as part of the email. 
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Email Basics (Gmail) 

 

THE GMAIL HOMEPAGE 

 

 

 

 

 

 

 

 

 

 

 

Attachment 

Date sent 

Inbox 

Organize messages with Folders 

To create a new folder: 

1.  Click on folder icon 

2.  Scroll down and click on “Create 

New” 

3.  Press the Enter key 

 

  

Settings 

Compose an 

email 

Navigation 

bar 

Search by keyword or 

sender 
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COMPOSING AND SENDING EMAILS 

1. Click on (red box) “Compose” 

2. New message window opens 

 

 

 

 

 

 

 

 

 

 

 

Attach a 

document 

Cancel/delete 

an email 

Send an 

email 

Recipient’s address 

Copy someone on an 

email 



6 
 

 

 

 

ATTACHING A FILE  

1.  Click on paper clip icon 

2. Browse the computer for the file 

3. Click on the file 

4. Click Open  

5. Type in your message  

6. Click Send  
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Computer Basics  

 

TERMINOLOGY 

Computer   An electronic device for storing and processing data 

Desktop   The primary display area of a computer screen 

Desktop Computer   A computer with a separate monitor, keyboard, and processor 

Flash Drive    A pocket-size data storage device used to save electronic files 

Icon     A small graphical representation of a computer program  

Laptop Computer   A computer that contains the monitor, processor, & keyboard in one unit 

Monitor   A computer component that allows users to view images 

Start Menu    The central launching point for programs and tasks in a Windows computer 

System Tray    A stationary taskbar that contains icons for system functions 

Taskbar    A stationary strip of icons used to access frequently used programs 

Window    An area of the screen that displays information for a specific program 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Icons 

 

Start 

Menu 

 

Taskbar 

 System 

Tray 

 

Desktop 
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Keyboard & Mouse Basics 

Mouse A hand-operated device that allows users to move a cursor around a computer screen 

Keyboard A piece of equipment similar to a typewriter that allows users to enter data into a computer 

 

 

 

Right-Click 
Scroll 

Function Keys Numeric Keypad 

Typing Keys Navigation & Special 

Keys 

Left-Click 
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ADDITIONAL KEYBOARD & MOUSE PRACTICE 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Left-click the appropriate icon to open the Internet (Google Chrome, Mozilla Firefox or Internet 

Explorer).  

Double left-click on desktop 

icons to open programs 

Single left-

click on 

items in the 

Start Menu 

or from the 

task bar to 

open them. 
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Using a PC (Windows 11) Learner Handout 

 

 
Desktop Terminology 

Account – Menu used to sign out and manage your account.  

All Apps – Menu that lists all the applications available on the computer in alphabetical order. 

Applications – Tools that allow you to do things on a computer, such as write a letter using Microsoft 

Word, search the internet using the Edge browser and do math using a calculator. 

Desktop – The area that allows you to access the applications, files, and settings. 

File – A package of information.  

Folder – A method for storing and organizing files.  

Power – In the Start Menu, it’s where you restart, shut down, or put the computer to sleep. 

Recycle Bin – Holds deleted files until you empty it.   

Settings -- Menu used to change preferences, customize the desktop, and more. 

Taskbar 

Recycle Bin 

File 

Folder 

Application 

Search Box Task View Start Menu 

Desktop 



11 
 

Taskbar – Access the Start Menu, search, frequently accessed applications, open files, settings, 

notifications, and control functions.  

Search Box – Search the computer for a specific file, computer setting or application.  

Start Menu – Access all applications available on the computer; shut down, restart and put the 

computer to sleep; manage user accounts, access files and computer settings. 

Task View – Displays all the windows that are currently open on the computer. 

 

Power Menu Options 

Lock: Requires a username and password to access the computer. 

Sleep: Power saving mode for when you’re not using the computer. 

Shut down: Closes all files and applications and turns the computer off.  

Restart: Closes all files and applications and turns the computer off and turns it back on.  

 

Title Bar  

 

 

 

Close Button: Closes the application or file.  

Maximize Button: Expand the window to fill the desktop. 

Minimize Button: Hides the file in the taskbar.   

Restore Button: Returns the window to the size it was before it was maximized.  

Scroll: Use this tool to see more of the file contents that is not visible on the current screen. 

Title Bar: At the top of every window it includes the name of the software name, file name, and 

includes the minimize, maximize, restore and close buttons. 

Save: Use this feature so you have a copy you can view or edit later.  

Window: Working area of an application. 

 

Minimize 

Save Maximize Close 
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Tips for Using a PC 

• Desktop and Taskbar are useful tools to access common applications and documents. 

• Task View allows you to see all the open windows at one time.  

• Folders help you organize files.  

• The Search box allows you to quickly locate folders and documents. 

• Documents can be restored from the Recycle Bin only if it has not been emptied. 

 

  

Window 

Resize – When a window is too big or too small you 

can change the size of the window. 

1. Place the cursor on the edge of the window.  

2. When the cursor becomes a double-headed 

arrow, click and hold the left mouse button to 

“grab” the edges of the window. 

3. Drag the mouse to the left or right to change 

the size of the window.  

4. Release the mouse button when the window 

is the desired size.  

Scroll 
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Windows 11 Basics   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

   

  

 

 

 

New Start Menu 

1. Search Bar at the top 

2. Tiles gone and replaced 

with icons 

3. Can still create folders by 

dragging an icon on top 

of another one 

4. Recommended items are 

located at the bottom of 

the start menu unless 

turned off 

5. Your Profile 

6. Power icon now in 

bottom right corner 

 

New Right Click 

Menu 

1. Cut 

2. Copy 

3. Rename 

4. Share 

5. Delete 

1 

2 

3

 

6 

4 

5 

Original Menu with 
full options 

1       2      3       4      5 
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1) Basic functions: cut, paste, rename, 
etc. 

2) Navigation menu 
3) Quick Access Items 
4) All files 
5) Change icon size with view 
6) File search bar 

1 

2 

 
3 

 

4 

 

5 

 

6 

 

Settings 
• System: Make all icons larger, Night 

light, HDR and Multiple monitors 
• Bluetooth & Devices: Bluetooth 

connection and settings for printers, 
Scanners and your mouse. 

• Networking & Internet: Wi-Fi 
connections and settings 

• Personalization: Change desktop 
and lock screen pictures 

• Apps: Deleting apps/programs and 
setting default programs 

• Accounts: User account settings 
• Time & Language: Set date and 

time 
• Accessibility: Change the size of 

your text, mouse pointer, text cursor, 
and magnification options. 

• Privacy & Security: Privacy options 
and Windows security (Defender) 



15 
 

Computer Basics (macOS 11)  

Learner Handout  

 
 
 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Dock 

Desktop Terminology    
Apple Menu: From this menu, you can access System Preferences and recently used apps. You can 

also view information about the computer, sign out, and lock or change settings unique to your 

account. 

 

Menu Bar: Includes the Apple Menu, the date, time, volume control, and more. Menus change 

depending on which program is open. 

 

Siri: A virtual assistant that responds to voice commands by using the computer speakers. 

 

Search: You can search the computer for a specific file, computer setting, or application.  

 

Desktop: The area that allows you to access the applications, files, and settings. 

 

Folder: A method for storing and organizing files.  

Trash 

File 

Folder 

Applications 

Desktop 

 

Launchpa
d 

Menu Bar 

 Apple Menu  Search  Siri 
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File: A package of information.  

 

Dock: Find frequently accessed applications, open files, and empty the Trash.  

 

Launchpad: Lists all applications available on this computer. 

 

Applications: Tools that allow you to do things on a computer, such as write a letter using Microsoft 

Word, search the internet using the Safari browser, and do math using a calculator. 

 

Trash: Holds documents until you empty them. 

 

 

Title Bar  
 

 
 

 

Title Bar: You can find this at the top of every window. It includes the name of the application that’s 

open and the name of the file. It also includes the Minimize, Maximize, Restore, and Close buttons. 

                 

Save: Use this feature so you have a copy that you can view or edit later. 

 

 

 
 

Close Button: Closes the application or file (red circle).  

 

Maximize Button: Expands the window to fill the desktop (green circle). 

 

Minimize Button: Hides the file in the Taskbar (gray circle).   

 

Restore Button: Returns the window to the size it was before it was maximized (also the green circle). 

 

 

 

 

 

 

 

 

 

Application Open 
Name 

Save 

File Name 
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Scroll: Use this tool to see more of the file contents that is not visible on the current screen. 

 

Window: Working area of an application. 

 

 

Tips for Using a Mac 
• The Desktop and Dock are useful tools to access common applications and documents. 

• Folders help you organize files.  

• The Search box allows you to quickly locate folders and documents. 

• Documents can be restored from the Trash only if nobody has emptied it. 

 

 

  

Resize: When a window is too big or too small, 

you can change the size of the window. 

5. Place the cursor on the edge of the 
window.  

6. When the cursor becomes a double-
headed arrow, click and hold the left 
mouse button to “grab” the edges of the 
window. 

7. Drag the mouse to the left or right to 
change the size of the window.  

8. Release the mouse button when the 
window is the desired size.  

Scroll Window 
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Learner Handout: Internet Basics 

 

 

 

Parts of a Web Browswer 

Browser Window – Is how you view and navigate Web Pages. Within a Browser Window you can 

have multiple Tabs. You can also have multiple Browser Windows open at the same time. 

Web Address – Tells the computer the correct combination of letters, numbers, and/or characters to 

reach a particular website. It’s like the street address for a Website! 

Address Bar – The box where you type a web address (URL). It can also be used to search for 

information and view content on the Internet.  

Home – This is the Website page that first appears when you open your browser. You can select 

which Web Page you want as your homepage in the web browser’s Settings. 

Back/Forward – Clicking the Back button takes you to the previous page you were on. Forward 

returns you to the page you were on before you hit the back button. 

Refresh – This re-loads the page you are on to ensure the web content is up to date or to fix any 

issues if the page didn’t load properly. 

Tab – When you open a browser, you start with one tab which loads your Home Page. You can use 

this tab to visit other Websites by entering a URL into the Address Bar. To visit multiple sites or 

Navigation Buttons: Back, Forward, 

Refresh, Home 

 Address Bar 

 

Tabs Options and 

Settings 

Bookmarks  
 

 

 

 
Navigation Menu 

 

 Search 

Box 

 

 
Main Content 
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compare different Websites side-by-side, you can open multiple tabs within one browser window and 

switch back and forth. 

Options/Settings – Contains all the Settings you need to set up the browser. Includes tools such as 

Display (zoom, font, themes, etc.), History (previous sites visited), the Print features and more.   

Bookmarks – Save sites you visit frequently so you can quickly access them via the bookmarks 

toolbar. 
 

Internet Terminology 

Internet – A system of interconnected global computer networks that allow people to share digital 

information with one another. 

Web – A system of online documents that are linked together, like a spider “web” (hence the term 

World Wide Web).    

Hyperlink – It is an element on the webpage that when clicked takes you to another document on 

the Internet. 

Website – A collection of Web Pages that are linked together that provides information about a 

particular business, group, organization, or person. 

Web Page – An electronic document with text, images, video and other links that is accessed by 

clicking a Hyperlink from the Results List or Web Page in a Web Browser. 

Home Page – The landing page or main page of a Website that provides links and a Search Box to 

find information on other pages within the Website.   

Web Browser – Also known as a Browser Window. It is a program that allows you to view Websites 

and navigate between them using Hyperlinks. 

Cloud – A term used to describe web-based applications and/or files that are stored and accessed on 

the Internet (usually with a login and password) from a shared, remote server and not on your 

computer’s hard drive. 

Domains (the last few letters of the address after the .) USUALLY gives users an indicator about the 

type of site they’re visiting. Examples include: .com = commercial business or company; .org = was 

originally used by non-profits but is now also available to politicians, political parties and online 

communities.; .gov = government agency and .edu = educational institutions. 

 

Parts of Website 
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Navigation Menu: A collection of links to the main sections of the Website. Navigation Menus 

usually appear near the top of the page. Click on these links to browse other sections of the Website. 

Search Box: Just like a Search Engine searches the Internet, the Search Box on a Website allows 

visitors to search for specific information on the Website they are visiting.  

Main Content: The big area in the middle of the Web Page that contains most of the unique content. 

Examples: a story you want to read, a video you want to watch, a recipe you want to bake, etc.   

Footer: A collection of links that appears on the bottom of each page and often includes basic 

information about the website or company including contact information, terms of use, social media 

links and more.  

Sidebar Navigation: A collection of links that allows the user to navigate to information in a 

particular section of the Website. 

 

Using Search Engines (example: Google)  

Search Engine – A Website that allows you to look up information and view content on the Internet. Some 

examples of commonly used search engines are Bing, Google and Yahoo! 

Search Box – Used to enter keywords when the exact address is unknown. Some browsers only have a single 

“omnibox” that is used to enter both web addresses and keywords (like Google).  

 

Tips & Tricks 

Use these tricks to search the Internet like a pro. 

 

 

 

Search 

Box: Type 

keywords 

or search 

terms 

Access other 

Google tools for 

more options 
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1. Use quotation marks around a phrase to limit results to the terms inside the quotation marks in that 

particular order. 

▪ Ex. “Illinois State Fair” retrieves results with Illinois State Fair in the title but not Iowa State Fair 

2. Use connectors AND, OR between keywords to broaden or narrow your search. 

▪ Ex. Chicago AND events, Chicago AND events OR museums 

3. If you want to exclude terms from the search results use the (-) minus symbol.  

▪ Ex. Cardinal -baseball 

 

4. A search for Chicago Tribune is the same as searching for chicago tribune. 

 

5. Search Suggestions: Many Search Engines suggest possible search terms as you type your search in the 

Search Box.  

 

6. Many Web Browsers allow you to search the Internet from the Address Bar. If you see the magnify glass in 

the Address Bar you can enter your search term in the box to search the Internet. 

 

 
 

7. You can search for a specific format including images, music, videos and news. To do this type your search 

in the search box, submit your search, and then select the type of format you want in the results list.   

 

8. Ads in Search Results. Search engines sometimes display ads related to the search result. 

 

9. Review results carefully before clicking on a link to be sure it is the best match for your needs. 

 

10. If you aren’t getting an exact match or the results look off, be sure to check for the following: 

▪ Additional pages of results (appearing in number form at the bottom of the page) 

▪ Helpful hints from the Search Engine, like “Also try,” or “Searches related to” 

 

 

 

 Limit Search 

To A  

Specific 

Form
Ads in Search 

Results 
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Mobile Device Basics — iOS Learner Handout 

 

External Buttons and Charging Port 

 

 

 

 

 

 

Touch Gestures 

To control your mobile device, you touch the screen of the device with your finger and use gestures to 

navigate and perform different functions. There are a few standard gestures that are important to 

remember. 

Side Button:  

Power Button 

Volume Up 

Ring/Silent Switch 

Charging Port 

Volume Down 
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Tap: Use this to activate a control or select something on 

the screen. For example, you can tap on an app to open it. 

 

Tap and Hold: Use this to display a menu of options. 

 

Swipe Up and Down: If the text goes beyond one screen, 

you can scroll up and down by swiping up and down. You 

will also swipe up from the bottom of the screen to go to 

the Home screen. 

          

Swipe Left and Right: If you want to see what apps are 

available on your phone, swipe left and right in the App 

View. 

 

Common Apps 

 

Browser 

App Store 

Maps 

Phone 

Messaging 

Camera 

Email 
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Tips for Wi-Fi Security 

Follow these tips to keep your information safe when you connect to Wi-Fi.  

1) Make sure you trust a public network before connecting to it. Do you know who set up the 

network?  

2) Try not to send private information over public Wi-Fi networks.  

3) If you do send personal information, make sure the website is secure and begins with https.  

4) Set up a password for your home network to block intruders from accessing it.  

 

 

Locking and Unlocking Your Phone 

 

One of the most important things you can do is set a personal 

identification number (PIN) or passcode to access and use your 

mobile device. This will help protect the data stored on your device 

if it is ever lost or stolen. Each time you turn on your device or wake 

up the screen, you will see a prompt to unlock it. 

 

To set a PIN or passcode, tap Settings. Then scroll to Face ID & 

Passcode. You’ll find the options there.   

  

You can also use unlock your phone using Face ID. You would need 

to follow the prompts to store that information in your settings 

before you can enable this feature.  

 

Please explore these settings and be sure to use one of the 

approaches to lock your phone to keep your data safe and secure. 
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Privacy Settings 

 

Privacy settings are also important for mobile devices. Using your 

phone’s privacy settings, you can decide which apps have 

access to information and data stored on your device, such as 

your location, photos, and microphone. 

  

To access the privacy settings, go to Settings. Then scroll 

down. Then tap Privacy and follow the prompts.  

 

Please explore these settings and be sure to set up your 

phone in ways that keep your data safe and secure. 

 

  

 

 

 

 

 

 

 

 

 

Accessibility Settings 

 

Accessibility settings on your mobile device can help you customize your phone to meet your visual, 

physical, motion, or hearing needs. To find the Accessibility features, tap Settings. Then scroll down 

the page and tap Accessibility.  

  

Common features to explore include magnifying the screen using the Zoom feature, changing the 

display, modifying the text size, and more. 

 

Please explore accessibility settings after the workshop to make sure you are meeting all of your 

needs. 
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Mobile Device Basics—Android Learner Handout 

 

External Buttons and Charging Port 
 

 
 
 
 
 
 

 

 

 

 

 

Touch Gestures 
 

To control your mobile device, you touch the screen of the device with your finger and use gestures to 

navigate and perform different functions. There are a few standard gestures that are important to remember. 

 

Power Button Volume 

Ring/Silent Switch 

Charging Port 
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Tap: Use this to activate a control or select something on 
the screen. For example, you can tap on an app to open it. 

 
Tap and Hold: Use this to display a menu of options. 

 

Swipe Up and Down: If the text goes beyond one screen, 
you can scroll up and down by swiping up and down. You 
will also swipe up from the bottom of the screen to go to the 
Home screen. 

          

Swipe Left and Right: If you want to see what apps are 
available on your phone, swipe left and right in the App 
View. 

 

Common Apps 

 

 

Camera 

Browser 

Play Store 

Phone 

Email 

Messaging 

Maps 



28 
 

 

 

 

Tips for Wi-Fi Security 
 

Follow these tips to keep your information safe when you connect to Wi-Fi.  

 

1) Make sure you trust a public network before connecting to it. Do you know who set up the network?  

2) Try not to send private information over public Wi-Fi networks.  

3) If you do send personal information, make sure the website is secure and begins with https.  

4) Set up a password for your home network to block intruders from accessing it.  

 

 

Locking and Unlocking Your Phone 

 
One of the most important things you can do is set a personal 

identification number (PIN) or passcode to access and use your mobile 

device. This will help protect the data stored on your device if it is ever 

lost or stolen. Each time you turn on your device or wake up the screen, 

you will see a prompt to unlock it. 

 

To set a PIN or passcode, tap Settings. Then look for the option to lock 

the screen.   

 

You can also use unlock your phone using Face ID, iris scan, or 

fingerprint. You would need to follow the prompts to store that 

information in your settings before you can enable this feature.  

 

Please explore these settings and be sure to use one of the approaches 

to lock your phone to keep your data safe and secure. 
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Privacy Settings 
 

Privacy settings are also important for mobile devices. Using your 

phone’s privacy settings, you can decide which apps have access to 

information and data stored on your device, such as your location, 

photos, and microphone. 

  

To access the privacy settings, go to Settings. Then tap the donut icon. 

Then tap Privacy and follow the prompts.  

 

The way you set your privacy settings may be different depending on 

the device manufacturer. Because of the variety of Android mobile 

devices, you may notice slight differences between your device and this 

example. 

 

Please explore these settings and be sure to set up your phone in ways 

that keep your data safe and secure. 

 

 

 

 

 

 

 

Accessibility Settings 
 

Accessibility settings on your mobile device can help you customize your phone to meet your visual, physical, 

motion, or hearing needs. To find the Accessibility features, tap on Settings. Then scroll down the page and tap 

Accessibility.  

  

Common features to explore include a voice assistant to get spoken guidance to navigate the device without 

needing to see the screen; changing text size, contrast, and display color of the screen; adjusting audio 

settings; and enhancing or changing the touch interactions.  

 

Please explore accessibility settings after the workshop to make sure you are meeting all of your 

needs. 
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Tablet Apps  

Below is a list of popular apps and staff favorites. Have fun exploring! 

SOCIAL MEDIA FINANCE TRAVEL COMMUNICATION 

Facebook Your Bank’s App Uber Yahoo, Gmail & Outlook 

Pinterest Mint Lyft The Weather Channel 

Twitter PayPal Waze CNN/ABC/NBC News 

Flickr Square Airlines Yahoo/Google/Bing News 

Instagram Expensify Kayaak Chicago Tribune 

SnapChat  Travelocity Sun-Times 

LinkedIn  TripAdvisor Tumblr 

 Skype  Priceline Blogger 

   TEDTalks 

HEALTH & WELLNESS  MOVIES, TV & VIDEO MUSIC & SHOPPING PRODUCTIVITY 

MyFitnessPal Netflix Pandora Evernote 

Fitbit Crackle Spotify Google Docs 

MapMyRun/Walk/Ride Hulu Shazam Google 

Drive/Calendar/Maps 

Yoga.com VUDU iHeartRadio Dropbox 

7 Minute Workout Cable TV Living Social Microsoft Office 

HealthTap Amazon Instant Video eBay Trello 

First Aid  

(The American Red Cross) 

Watch ESPN 

Fandango 

Amazon 

Retail/Department Stores 

Tiny Scanner 

Cozi Family Calendar 

Luminosity IMDb ScanLife Genius Scan 

Relax & Rest Guided 

Meditation 

YouTube Red Laser 

ShopAdvisor 

 

SparkRecipes  Groupon 

Zillow Real Estate 
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LinkedIn Basics  

 
 

LinkedIn URL: www.linkedin.com  

 

TERMINOLOGY 

Connection     A person to whom you are directly connected.  

Potential Connection   A Connection of a Connection.  

Recommendation  An online paragraph or letter of support written by or for one of your 

Connections.  

Toolbar The stationary navigation bar at the top of each screen. Contains the 

Search box and links to the Home page, Profile page, My Network, 

Jobs, Interests, Messages, Notifications, Grow My Network, and 

Account & Settings. 

 

HOME PAGE 

 

 

 

 

 

 

 

 

 

 

http://www.linkedin.com/
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PROFILE PAGE 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

CREATE AN ACCOUNT 
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To create an account, type the following pieces of 

information into their corresponding boxes: 

1) First name 

2) Last name 

3) Email address 

4) Create a password (6 or more characters) and 

type it into the Password box.  

Note: Be sure to write your password down or email 

it to yourself for future use 

5) Click the Join now button at the bottom of the 

screen and follow the wizard’s directions. 
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LinkedIn: Getting Started 

 

 

HOMEPAGE 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Notifications Search Box 

Update your status, Upload    

a photo, or Publish a post 

 

Newsfeed 

Page links 

 

ADDING SECTIONS 
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PROFILE SECTIONS 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ADDING CONNECTIONS 

 

 

 

 

 

  

To Add a Connection: 

1. Type their name in the 

Search box and click on 

     the          button 

2. Click on the Connect 

button that appears under 

their picture  

OR 

1. Click on the drop-down 

menu next to the Send 

InMail button 

2. Click on the Connect 

button 
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Video Conferencing Basics Learner Handout 

 

Joining a Meeting 

For many of us, the first time we use a video conferencing tool is when someone else invites us to a 

meeting. We typically receive an invitation through email.  

 

 

 

 
 

  

Who is inviting you 

Topic 

Date and Time 

Link to join 

Meeting ID and Passcode 

Phone numbers 
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Common Participant Features 

Common features you’ll use when you join a Zoom meeting include: 

1) Muting and unmuting your microphone. 

2) Turning your video camera on and off. 

3) Chatting with others in the meeting. 

4) Sharing your screen. 

5) Using reactions and raising your hand. 

6) Changing the view from gallery to speaker view.  

7) Viewing a list of other participants. 

8) Leaving the meeting. 

 

 
 
  

1. Mute and Unmute 

2. Video Start and Stop 

3. Chat 

4. Share Screen 

5. Reactions 

6. Change View 
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7. View Participants 

8. Leave Meeting 

1. Mute and Unmute 

2. Video Start and Stop 

4. Share Screen 

7. View Participants 

More features 

8. Leave Meeting 
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Learner Handout: QR Code Basics  

 

What is a QR Code? 

A QR code is like a barcode. You scan the QR code with your smartphone or tablet’s built-in camera app, which 

connects you to a resource on the Internet, such as a website for viewing a food menu, an advertisement, or an 

application for making a payment, among other uses. 

 

What can you do with a QR code? 

Examples include accessing a restaurant menu, checking in for a doctor’s appointment, paying for parking, 

downloading an app, watching a video, taking a survey, and more.  

 

How to Scan a QR Code  

 

O 

P 

T 

I 

O 

N 

A 

     
Step 1.  

Tap the screen of 

your smartphone 

or tablet with your 

finger. 

Step 2.  

Tap the camera 

icon. 

Step 3.  

The camera 

app opens. 

 

Step 4.  

Hold the device 

so that the QR 

code appears in 

the camera’s 

viewfinder, 

making sure 

the entire code 

is visible on the 

screen. 

 

Step 5.  

The device 

will 

automatically 

detect it’s a 

QR code and 

display a link. 

Do not take a 

picture of the 

QR code! 

Tap the link 

on the screen, 

and the link 

opens. 

 

O 

P 

T 

I 

O 

N 

B 

 

 

Step 1. 

 From the home 

screen, navigate 

to the page with 

camera icon. 

Step 2. 

Tap on the 

camera icon with 

your finger. 

 

 
Continue to 

Step 4. 

 

Tips to Help You Successfully Scan a QR Code  
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• If you accidentally take a picture of the code, return to the camera app and scan the code again!  

• Remember, tap the URL under the QR code in the camera app to open the resource.   

• Keep the camera steady. The camera can’t read the code if the image is moving or blurry. 

• Check your browser if you tap the QR code link, but nothing opens. 

• Clean the camera lens if the image is blurry.  

• Make sure the entire code fits on the screen with a little space between the code and the edge of the 

camera screen. 

• Turn on the camera’s flash if it’s dark. 

• If you have an older device, you may need a QR scanner from your device’s app store.     

Using QR Codes Safely and Securely  

Do 

• Do only scan codes from trusted sources. The item that opens after scanning the code should match 

the organization promoting the QR code. How can you tell? 

o The QR code name or branding should match the organization’s website. 

o Make sure the organizational name in the URL or logo is spelled correctly — if it's not, be 

suspicious. 

o The item the QR code opens should look professional, which means no misspellings, typos, or 

grammatical errors. 

o If it is too good to be true, it probably is! 

• Do go directly to the organization’s website address if you are unsure the QR code is legitimate. 

• Do make sure your device’s operating system and applications are up to date to ensure you have the 

most recent security updates installed. 

• Do make sure the URL starts with HTTPS. 

• Do contact the organization to verify it’s safe. If you are at a store or restaurant and are unsure 

whether the QR code is safe, ask the staff.  

• Do: If you provide personal or financial information using a fraudulent QR code, what can you do? 

o If you entered your username and password, change your password.   

o If you provided bank or credit card information, set up a fraud alert and credit freeze. Contact 

your financial institution for help.  

o Inform your bank and monitor your accounts for unusual activity. 

o Scan your device for malware and spyware.  

• Do watch the PLA DigitalLearn course Online Fraud and Scams at www.digitallearn.org to learn more 

about using your mobile device safely and securely.  

Don’t 

• Don’t scan QR codes that are damaged or covered by a sticker of a different QR code. Someone may 

be trying to trick you by directing you to a different website. 

• Don’t give sensitive information to a company or person you don’t know like your social security 

number, credit card, bank information, and passwords. 

• Don’t scan it if you are unsure it’s safe. 
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Cybersecurity Basics- Learner Handout 
Cybersecurity is all about the safety of information— our identity, our personal data, and our financial 
assets— when we’re online.  

Cybersecurity means that 1) your personal data is accessible only to you or others you authorize, and that 
2) your devices— laptops, desktop computers, mobile phones, tablets— work properly and are free from 
malware.  

Tips for Strong Passwords 
• Avoid common words like “password” or “123456.”  
• Don’t include personal information like your address or name. 
• Don’t use the same password on multiple accounts and websites. 
• Don’t share your password with others. Passwords should be kept private.  
• Make the password longer. The best defense is length. Longer passwords don’t need to be 

complex and hard to remember.  
• Use short phrases like “cowshelpmakecheese.” 

Protect Yourself from Online Fraud and Scams  

Types of Common Scams 

Phishing 

Scammers “fish” for sensitive information like passwords, Social Security Numbers, credit card and bank 
account details, or other personal data. Phishing occurs when fraudsters or scammers use fake emails, 
text messages, phone calls, social media profiles, websites, online games, surveys, or quizzes, or free 
Wi-Fi to gain access to sensitive information. Once you enter your information on a fake site, they will 
have you "hooked." The scammers can use this information to gain access to your money or steal your 
identity. 

Social Engineering 

Social engineering occurs when a fraudster uses emails, text messages, phone calls, or social media 
profiles to gain your trust by convincing you they are someone they are not, to get personal information or 
money from you. Examples of social engineering include a person who   

• Claims to be a friend or family member in trouble, 
• Pretends to be a company with a great discount or offer, or 
• Claims to be working on behalf of a government agency, organization, or collection agency.  
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Dos and Don’ts to Avoid Scams  

Don’t 
• Don’t give in to the pressure to act now. Take the time you need to verify the request. 
• Don’t give any personal information to something that could be a scam. This includes name, 

email address, credit card number, or password. 
• Don’t share your personal PIN, password, or passcode. 
• Don’t give them money, including gift cards, prepaid debit cards, or transfer money. 
• Don’t reply or engage the fraudster. Doing this can notify the scammer that they’ve reached a 

real person, which can result in more scam emails, phone calls, or text messages. 
• Don’t use the contact information or link from the person who contacts you. 
• Don’t click any links or buttons. Doing this can take you to untrustworthy websites. 
• Don’t provide remote access to your device. That person would have complete control over it, 

including the ability to access your personal data or install malware. 
• Don’t download any files or attachments. They may contain viruses or malware that could harm 

your computer or collect your personal information.  
Do 

• Do take time to investigate the request. Check with a trusted person to verify it’s safe.  
• Do be skeptical. If you think something may be a scam, it probably is. 
• Do put the suspicious email into your spam folder.  
• Do look up contact information from another source. Go directly to the company’s website or 

check a statement you received in the mail. 
• Do only access websites that begin with HTTPS. 
• Do discuss with a trusted person. If you are unsure about the request, talk to someone you trust, 

like a friend or family member. Don’t let them rush you into making a quick decision.  
• Do register your phone number with DoNotCall.gov to request that telemarketers not call you. 
• Do close pop-up windows by holding down the ALT and F4 keys on a Windows keyboard or 

Command-W on a Mac. Don’t click on any buttons on the pop-up -- that includes the X! 
• Do use strong passwords that include upper and lowercase letters, numbers, and special 

characters. Longer passwords are also stronger passwords. 
• Do regularly update and patch your devices to ensure the latest security updates are installed. 
• Do use multi-factor authentication that requires two methods to verify access to your account, 

including a username and password, and another method such as a code sent to your email. 

How to Identify if You’ve Been Scammed  
Here are some tips to help you determine if you have been scammed. 

• Unexpected transactions show up on your bank or credit card statements. 

• Items you ordered and paid for did not arrive, and when you try to report the issue to the seller, you do not get 
a response.  

• You receive an email that there have been an unusual number of unsuccessful sign-in attempts for one of your 
accounts, but you have not tried to log in. 

• You can’t log into your account, and you cannot reset the password. 

• You can’t withdraw money from your account, and when you log into your bank account, the balance is zero, or 
it has been closed. 

• The person you were communicating with disappears. You reach out to them via email, text, or social media, 
but they no longer respond, or you can’t locate their online profiles anymore.  

https://www.donotcall.gov/
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• You notice signs of malware on your device, such as pop-up ads that are hard to close, new or unfamiliar 
toolbar icons, or your computer or mobile device not responding as fast as it used to.  

 

How to Report Scams 
Here are a few actions you can take if you identify or fall victim to a scam. 

• If you come across a phishing scam impersonating a known organization, you can reach out to the organization 
being impersonated. For an IRS phishing scam, forward it to phishing@irs.gov. 

• Mark fake emails as spam or junk. This helps email providers identify and prevent scams. 

• Contact bank and credit card companies right away if you notice any unauthorized transactions.  

• Freeze your credit report so someone else can’t apply for credit cards or loans in your name.  

• Change your passwords if you think someone is trying to access your account, you gave your password, or you 
were notified that your account may have been compromised through a data breach, unsecured internet 
network, malware, or phishing attempt.  

• File a complaint with one of the following federal or state agencies: 
o Federal Trade Commission at reportfraud.ftc.gov 
o Federal Bureau of Investigation's Internet Crime Complaint Center at www.ic3.gov 
o Your state’s attorney general at usa.gov/state-attorney-general 

• Report suspicious activity to your phone and internet service provider. If you think your identity was stolen or 
your information was exposed in a data breach, check the IdentityTheft.gov website to explore your options, 
report the theft, and create a recovery plan.  

• Stay Alert: Protect Yourself from Scams 
o Be cautious of unexpected phone calls, texts, or emails asking for your personal, account, or credit card 

information.  

  

mailto:phishing@irs.gov
http://reportfraud.ftc.gov/
http://www.ic3.gov/
https://usa.gov/state-attorney-general
https://www.identifytheft.gov/
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Microsoft Word: Basics  

 

BASIC ELEMENTS OF THE PROGRAM WINDOW 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

THE RIBBON 

 

 

 

 

 

 

 

View Buttons Zoom Slider 

Quick Access Toolbar 

Document Window 

Horizontal & Vertical Rulers 

Title Bar 

Status Bar 

Minimize, Maximize, Close 

Scroll Bar & Arrows 

File Tab  Tabs 

Groups Launcher 
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SAVE & SAVE AS 

  

 

 

 

 

 

PRINTING 

 

  

 

 

 

  

Tab  Groups 

Home  Clipboard, Font, Paragraph, Styles, & Editing 

Insert  Pages, Tables, Illustrations, Add-in, Media, Links, Header/Footer, Text, & Symbols 

Design Themes, Document Formatting, Page Background 

Page Layout Page Setup, Paragraph, & Arrange 

References Table of Contents, Footnotes, Citations, Captions, Index, & Table of Authorities 

Mailings Create, Start Mail Merge, Write/Insert Fields, Preview Results, & Finish 

Review Proofing, Language, Comments, Tracking, Changes, Compare, & Protect 

View  Document Views, Show, Zoom, Window, & Macros 

The exception is the File tab which includes general commands along with file options. On this tab 

you will find Info, New, Open, Save, Save As, Print, Share, Export, Close, Account, and Options. 

PRINTING 

1. Click File 

2. Click Print on the menu 

3. Check Printer Settings & adjust if necessary 

(Copies, Pages, Double-Sided, etc.) 

4. Click the Print button 

 

SAVE AS 

1. Click File 

2. Click Save As 

3. Select the location 

4. Name the 

document 

5. Click Save 

Save 
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Microsoft Excel: Basics  

 

The Excel Window 

 

 

 

 

 

 

 

 

The Ribbon & Home Tab 

 

 

 

 

Tips 

• If you make a mistake when entering data press the ESC key 

• To undo an entry, click the Undo button on the Quick Access Toolbar  

• To use spell-check, click the Review Tab, then the Spelling & Grammar button 

• When numbers suddenly change to #### it means that the cell is too narrow to display them. 

Widen the column by double-clicking on the right edge of the cell border to auto-adjust the 

size, as shown below, or by placing the cursor on the column border and dragging it to the 

right until you achieve the desired width.  

Ribbon Tabs 

Command Group Dialog Box Launcher 

Zoom Slider 

Quick Access Toolbar – Includes Save, Undo/Redo and 

other frequent commands you place there (Ex: Print)  
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Mouse Pointer Shapes in Excel 

   

 

 

 

 

Excel Shortcuts – To use a shortcut, press & hold the CRTL key then tap the other key 

Command Press Ribbon Tab 

Beginning of Sheet Ctrl+Home 
 

Bold formatting Ctrl+B Home 

Copy Ctrl+C Home 

Copy value from cell above Ctrl+'(Single Quote) 
 

Cut Ctrl+X Home 

Display all formulas and their values 

for all formulas on a worksheet 

Ctrl+` (Single Left Quotation 

Mark Above Tab Key) 

Formula, Formula Auditing, 

Show Formulas 

End of Sheet Ctrl+End 
 

Enter the Date Ctrl+; (Semicolon) 
 

Find Ctrl+F Home 

Go to a specific Cell F5 Home 

Hide columns Ctrl+0 (Zero) Home, Cells, Format 

Hide rows Ctrl+9 Home, Cells, Format 

Italic formatting Ctrl+I Home 

Move to next worksheet Ctrl+Page Down 
 

Move to previous worksheet Ctrl+Page Up 
 

New line in cell Alt+Enter  

New Workbook Ctrl+N File  

Paste Ctrl+V Home 

Print Ctrl+P File  

Clear ALL formatting 
 

Home, Editing, Clear 

Repeat the last action F4 
 

Save Ctrl+S File  

Save As F12 File 

Spelling F7 Review 

Underline Ctrl+U Home 

Undo Ctrl+Z Quick Access Toolbar 

Unhide columns  Ctrl+Shift+) Home, Cells, Format 

Unhide rows Ctrl+Shift+( Home, Cells, Format 

 

Select a cell or range 

Drag a selected cell or range 

Fill – Copies values or a series of values  

Entering or editing data 

Resize column 

Resize row 

Select whole column 

Select whole row 
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Microsoft PowerPoint: Basics  

Terminology 

PowerPoint An application for creating custom slide show presentations 

The Ribbon The area where commands are organized into Tabs, icons, & Groups 

Tabs The areas within the Ribbon where like features are organized 

Groups The areas within Tabs where related task functions are organized 

Slide Each individual screen in a PowerPoint presentation 

Navigation 

Pane 

The display pane on the left side of the PowerPoint window that provides a 

preview of all slides in your presentation and allows for quick navigation 

Layout The pre-arranged placeholders on each slide allowing for content to be quickly 

added 

Themes Pre-designed background graphics, color combinations, and font pairings that 

enhance the image of your slides 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

PowerPoint Program Window 

 
Quick Access Toolbar Tabs Minimize, Maximize, Close 

Groups The Ribbon 

Navigation 

Pane 

Slide 

Zoom Slider 
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Adding a New Slide 

1. Click on the Home tab 

2. Click on the New Slide button 

3. Enter the appropriate content in the boxes 

provided (Hint: Use the Insert tab to add images, 

graphs, etc.) 

Using the Navigation Pane 

Duplicating Slides 

1. Right-click on the 

appropriate slide 

2. Click on 

Duplicate 

Deleting Slides 

1. Right-click on the 

appropriate slide 

2. Click on Delete 

Slide to remove it 

Re-arranging Slides 

1. Click on the 

appropriate slide 

2. Drag it to the 

intended position 

 

Adjusting Slide Layouts 

1. Click on the appropriate slide 

2. Click on the Home tab 

3. Click the Layout button and use 

the drop-down menu to select 

the desired layout 

Applying a Theme 

1. Click the Design tab 

2. Click on a theme to apply 

it.  

(Hint: Apply themes to one 

or all slides. Right-click on 

a theme for more options.) 

Playing a PowerPoint Presentation (“Slide Show”) 

 
1. Click the Slide Show tab 

2. Click the From Beginning button 

3. Enjoy the show by clicking through 

the slides 

4. Click at the end to return 
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MS Publisher: Basics  

 

 

 

 

 

 

 

 

 

 

 

 THE RIBBON 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tab   Groups 

Home   Clipboard, Font, Paragraph, Styles & Objects 

Insert   Pages, Tables, Illustrations, Building Blocks, & Text 

Page Design  Page, Layout, Pages, Schemes, & Page Background 

Mailings  Start, Write & Insert Fields, Preview Results, & Finish 

Review  Proofing & Language,  

View   Views, Layout, Show, Zoom, & Window 

The exception is the File tab which includes general commands with file options. On this tab 

you will find Save, Save As, Open, Close, Info, Recent, New, Print, Save & Send, Help, 

Options, Exit. 

Quick Access Toolbar 

Document Window 

Horizontal & Vertical Rulers 

Title Bar Minimize, Maximize, Close 

Scroll Bar & Arrows 

Zoom Slider 

 Tabs Group 

Page Navigation 

BASIC ELEMENTS OF THE PROGRAM WINDOW 
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SAVE & SAVE AS 

  

  

 

 

 

 

 

 

  

 

 

 

  

PRINTING 

5. Click File 

6. Click Print on the menu 

7. Check Printer Settings & adjust if necessary (Copies, 

Pages, Double-Sided, etc.) 

8. Click the Print button 

 

Save 

SAVE AS 

6. Click File 

7. Click Save As 

8. Select the location 

9. Name the 

document 

10. Click Save 

SELECTING A TEMPLATE 

1. Open Publisher 

2. Click Built –IN to access templates 

3. To see more templates within a group, click All 

4. Click on the desired design 

a. On the right-hand side, under Customize, change your Color, 

Font and Font scheme  

b. Under Options:  

• If your flyer is going to be folded and mailed without an 

envelope, put a check mark by Include mailing address 

• Select a Tear-off, if necessary (Depends on template type)  

5. Click Create on the lower right 

  

 



52 
 

 

Computer Basics (Windows 10) Learner Handout 

 

 

 

Desktop Terminology  

Account: From this menu you can sign out, lock or change settings that are unique to your account 

on the computer. 

Applications: Tools that allow you to do things on a computer, such as write a letter using Microsoft 

Word, search the internet using the Edge browser, and do math using a calculator. 

Desktop: The area that allows you to access the applications, files, and settings. 

File: A package of information.  

Folder: A method for storing and organizing files.  

Power: In the Start Menu, it is where you restart, shut down, or put the computer to sleep. 

Recycle Bin: Holds documents here until you empty them. 

Taskbar: Access the Start Menu, search, find frequently accessed applications and open files. The 

right-hand side of the taskbar includes notification center, date, time and volume control. 

Taskba
r 

Recycle Bin 

Folder 

Desktop 

 

File 

Application 

Task View Search Box 
Start  
Menu 
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Search Box: You can search the computer for a specific file, computer setting or application.  

Start Menu: Access all applications available on the computer; shut down, restart and put the 

computer to sleep; manage user accounts, access files and computer settings. 

Task View: Displays all the windows that are currently open on the computer. 

 

Title Bar  

 

 

 

Close Button: Closes the application or file.  

Maximize Button: Expand the window to fill the desktop. 

Minimize Button: Hides the file in the taskbar.   

Restore Button: Returns the window to the size it was before it was maximized.  

Scroll: Use this tool to see more of the file contents that is not visible on the current screen. 

Title Bar: At the top of every window it includes the name of the software, name of the file, and 

includes the minimize, maximize, restore and close buttons. 

Save: Use this feature so you have a copy you can view or edit later.  

Window: Working area of an application. 

 

 

 

Minimize 

Save Maximize Close 

Window 

Resize – When a window is too big or too small you 

can change the size of the window. 

9.  Place the cursor on the edge of the window.  

10. When the cursor becomes a double-headed 

arrow, click and hold the left mouse button to 

“grab” the edges of the window. 

11. Drag the mouse to the left or right to change 

the size of the window.  

12. Release the mouse button when the window is 

the desired size.  


